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Communications regulation information

FCC statement

This equipment has been tested and found to comply with the limits for a Class B
digital device in accordance with the specifications in Part 15 of FCC rules. See
instructions if interference to radio or television reception is suspected.

Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-
frequency energy. If it is not installed and used properly—that is, in strict accordance
with Apple’s instructions—it may cause interference with radio and television
reception.

This equipment has been tested and found to comply with the limits for a Class B
digital device in accordance with the specifications in Part 15 of FCC rules. These
specifications are designed to provide reasonable protection against such interference
in a residential installation. However, there is no guarantee that interference will not
occur in a particular installation.

You can determine whether your computer system is causing interference by turning it
off. If the interference stops, it was probably caused by the computer or one of the
peripheral devices.

If your computer system does cause interference to radio or television reception, try to
correct the interference by using one or more of the following measures:

m Turn the television or radio antenna until the interference stops.

m Move the computer to one side or the other of the television or radio.

m Move the computer farther away from the television or radio.

m Plug the computer into an outlet that is on a different circuit from the television or
radio. (That is, make certain the computer and the television or radio are on circuits
controlled by different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service
and support information that came with your Apple product. Or, consult an
experienced radio/television technician for additional suggestions. 

Important Changes or modifications to this product not authorized by Apple
Computer, Inc., could void the FCC Certification and negate your authority to operate
the product.
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This product was tested for FCC compliance under conditions that included the use of
Apple peripheral devices and Apple shielded cables and connectors between system
components. It is important that you use Apple peripheral devices and shielded cables
and connectors between system components to reduce the possibility of causing
interference to radios, television sets, and other electronic devices. You can obtain
Apple peripheral devices and the proper shielded cables and connectors through an
Apple-authorized dealer. For non-Apple peripheral devices, contact the manufacturer
or dealer for assistance. 

DOC statement

DOC Class B Compliance This digital apparatus does not exceed the Class B limits for
radio noise emissions from digital apparatus as set out in the interference-causing
equipment standard entitled “Digital Apparatus,” ICES-003 of the Department of
Communications.

Observation des normes—Classe B Cet appareil numérique respecte les limites de
bruits radioélectriques applicables aux appareils numériques de Classe B prescrites
dans la norme sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée
par le ministre des Communications.

VCCI statement
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P R E F A C E

This manual tells you how to install and use the hardware
and software that are part of the Apple TV/FM Radio System
so that you can

m watch TV or video and listen to the radio on your computer

m capture video or TV images on disk

m save radio recordings on disk

m determine which channels or radio stations you receive

m set up a password to restrict access to one or more TV
channels

m take advantage of available closed captions, video text, and
Second Audio Program (SAP) when you’re watching TV on
your computer

m manipulate basic TV and radio features with the included
remote control

m quickly switch among watching TV, listening to the radio,
and using your other computer application programs

Note: You use two separate applications to watch TV and
listen to radio, but you can do both on your computer at the
same time. However, you will not hear the TV while the
radio is playing.
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This chapter explains how to install the TV/FM tuner card
and software you need to watch TV and listen to the radio on
your computer. You’ll find information on how to

m install the TV/FM tuner card

m attach an FM radio antenna and a TV antenna (or cable
service connection) to the card

m attach a VCR (or other video device) to your computer’s
video input ports

m install the Apple FM Radio application program, which you
use to listen to the radio, and the Apple Video Player
application program, which you use to watch TV and video
(an installer installs both of these applications at once 
for you)

If you purchased your computer with the video input card,
TV/FM tuner card, and software already installed, skip the
instructions in this chapter for installing the TV/FM tuner
card. (Be sure to read the instructions and look at the
illustrations for attaching a TV antenna and FM antenna.) 

Installing the Card and Software

C H A P T E R
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2 Chapter 1

What you should have

Check your package to make sure you have everything you
see here. Your package also contains floppy disks from
which you will install the software later.

Note: Your remote control or FM antenna may look
different from the one shown here.

To install the TV/FM tuner card, you first attach it to the
computer, and then connect an FM antenna and a TV
antenna (or a cable service connection) to it.

Remote control

TV/FM tuner card

FM antenna



3Installing the Card and Software

Important The TV portion of your TV/FM tuner card will
not work if you do not have a video input card already
installed. To see if your computer has a video input card
installed, check the back of your computer for these three
protruding ports.

You need a video input card even if you do not intend to
connect any video equipment (such as a VCR or video
camera) to it. If you do not have a video input card, purchase
it separately from an Apple-authorized dealer and install it
according to the instructions that come with it. If you have a
video input card installed, go on to the next section.

The steps for attaching the TV/FM tuner card to your
computer vary slightly depending on whether or not your
computer has a built-in monitor.

If these ports are present, then a video input card is installed.



Installing the TV/FM tuner card in 
a compact computer

If your system has a built-in monitor, like this one, continue
with the steps below. Otherwise, go to the section that
follows, “Installing the TV/FM Tuner Card in 
a Modular Computer.”

4 Chapter 1



5Installing the Card and Software

Important Before you install the card, check the back of
your computer and make sure the access cover for the
TV/FM tuner card looks like the one on the computer on 
the left. 

If the access cover on your computer matches the
illustration on the left, continue with the instructions in this
chapter. (The rectangular opening in the computer on the
left accommodates both ports of the TV/FM tuner card.)

If the access cover on your computer looks like the
computer on the right, you need to purchase a replacement
for the back panel from an Apple-authorized dealer. After
you’ve purchased the new back panel, continue with the
instructions in this chapter.

The back panel on your
computer should have a
rectangular access cover.

If the back panel on your computer
has a small circular access cover,
you’ll need to purchase a
replacement panel from
an Apple-authorized dealer.



To install the TV/FM tuner card in a computer with a built-in
monitor, follow these steps:

Removing the logic board

1 Make sure you save any open documents and quit any open
applications. Then turn off the computer like this:

m First, choose Shut Down from the Special menu.

m Then press the power switch at the back of the computer.

Press the side of the switch marked with the j symbol.

2 Unplug all the cables except the power cord from your
computer.

Leaving the power cord plugged in helps protect 
the computer from damage by electrostatic discharge.

Important To avoid generating static electricity that may
damage the card or computer, do not walk around the room
until you have completed the installation of the card and
closed the computer. Additionally, move the logic board as
little as possible while it is outside the computer.

6 Chapter 1



7Installing the Card and Software

3 Use a screwdriver to remove the screws from the back panel.

Note: If you had to buy a new back panel and are removing
your old one, there are only two screws to remove, one on
each side.

Remove these three screws.



4 With your fingertips, locate the two latches on the underside
of the computer’s case.

Locate the two latches on the underside of the computer’s
case with your fingertips.

8 Chapter 1



9Installing the Card and Software

5 Pulling gently, swing the panel up and slip it out.

Remember: Don’t walk around the room until you have
finished installing the card and closed the computer. Move
the logic board as little as possible while it’s outside the
computer.

Pulling gently, swing the
panel up and slip it out.



6 There is a wire handle on the back of the logic board. Swing
it down and use it to pull the logic board toward you.

The logic board is plugged into a slot inside the computer,
so you may have to brace the computer with your other
hand and pull firmly at first. Slide the entire logic board all
the way out of the computer.

Wire handle
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11Installing the Card and Software

Installing the TV/FM tuner card

1 There is a ribbon cable inside the computer, held in place
under the logic board tray, at the bottom of the chassis. Pull
the cable gently a short way out of the opening. 

2 Remove the TV/FM tuner card from its static-proof bag. Hold
the card by its edges to avoid touching the connectors.

If the ribbon cable is taped down on the inside of the computer, 
remove the tape and gently pull the ribbon cable a short way
out of the opening so that you can attach it to the card. 

Ribbon cable
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3 Attach the plug on the ribbon cable to the connector on the
TV/FM tuner card.

Connector

Ribbon cable plug



13Installing the Card and Software

4 Slide the TV/FM tuner card into place under the logic board
tray. Fit the edges of the card into both of the guides there,
making sure the notches on the card point upward.

Make sure the TV/FM tuner card slides
into the guides along the underside
of the sheet metal logic board tray.

Sheet metal logic board tray
Install the TV/FM tuner card with
these notches pointing upward.



5 Locate the TV/FM tuner card access cover on the inside of
the plastic back panel.

Note: If you purchased a new back panel, locate the access
cover on the back of that panel.

Plastic back panel

TV/FM tuner card access cover
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15Installing the Card and Software

6 Remove the cover from its opening by squeezing together
the plastic tabs that hold it in place. 

Store the access cover; you may want to put it back in place
it if you ever remove the TV/FM tuner card.

Squeeze the two plastic tabs
together and pull off the metal
retainer so the access cover
can come off.

Metal retainer

Plastic back panel



Replacing the logic board

1 Swing the wire handle on the logic board back up into its
storage position, securing it under its catch. Then fit the
logic board into the guide rails on both sides of the
computer’s interior.

Make sure the logic board slides
into the guides that are on both
sides of the computer’s interior.

Swing the handle up, into its storage position.

16 Chapter 1



17Installing the Card and Software

2 Press the reset button on the logic board. Then gently but
firmly push on the vertical plate until the logic board is back
into place within the computer. You’ll need to push a little
harder at the end to make sure the connectors at the back of
the board are seated in their slot.

Note: If you can’t find the reset button, it may be in a
different location on your logic board. Check the manual
that came with your computer, in the section in the
appendix about installing expansion cards. There you will
find an illustration that shows where the reset button is for
your computer.

1  Press the reset button.

2  Gently but
firmly push on the
vertical plate until the logic
board is solidly back in place.
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3 Slip the three tabs at the top of the back panel into the
matching grooves in the computer case.

Note: If you purchased a different back panel from the one
that was originally on your computer, attach the new back
panel. You no longer need the old one.

Slip the three tabs on the
back panel into the grooves
in the computer case.
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4 Then snap the bottom of the panel into place, making sure it
is flush with the back of the computer.

Snap the plastic back panel into place.



5 With a screwdriver, insert and gently tighten one of the
provided attachment screws in the hole just to the left of the
TV/FM tuner card.

Reinsert this screw to secure the
TV/FM tuner card in the computer.

20 Chapter 1



21Installing the Card and Software

6 Reinsert the security screws on both sides of the back panel.

Reinsert both security screws.



Making connections to the TV/FM tuner card

After installing the TV/FM tuner card by attaching the card to
the computer, you then attach an FM antenna and a TV
antenna (or cable service connection) to the card. 

To attach FM and TV connections to the card, follow these
steps.

1 Turn off the computer if it isn’t already off.

m Choose Shut Down from the Special menu.

m Then press the power switch (marked with the j
symbol) at the back of your computer.

2 Attach the provided FM antenna to the FM port—the port on
the left, marked by the icon. Depending on the type of
antenna that came in your package, you may have to either
push or screw the connector onto the FM port.

FM antenna

Attach the FM antenna to the FM tuner port.
The FM tuner port is marked with the      icon.
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23Installing the Card and Software

3 Before you attach the TV cable, make sure it has an F-type
coaxial cable connector.

Important Do not attach or detach the coaxial cable while
the computer is turned on.

Note: If you want to view closed captions on a videotape
that has them, you must connect your VCR to the TV/FM
tuner card, not the video input card. For instructions on how
to do this, see the Appendix, “Viewing Closed Captions on
Videotape.”

F-type coaxial cable connectors



4 Using an F-type coaxial cable connector, connect the TV port
on the right, marked by the icon, to a cable service or to
a TV antenna.

5 Reconnect any cables you disconnected at the start of 
this process.

Because you pressed the reset button on the logic board
earlier, some of your computer’s software settings will have
changed (for example, the date and time on your computer
will need to be reset). You may want to open the control
panels for the date and time, keyboard, and mouse to make
sure that they are set the way you want them. For more
information about resetting these options, refer to
Macintosh Guide, available in the Guide (h) menu. (If you
do not have Macintosh Guide on your computer, see the
manual that came with your computer.)

Coaxial cable from an external TV antenna or cable TV service

Attach the coaxial cable to the TV tuner port.
The TV tuner port is marked with the      icon.
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25Installing the Card and Software

6 Unfold the FM antenna and position it high for the best
reception.

Attach the antenna to a wall in the position that gives the
clearest reception. Use tape, thumbtacks (through the
middle of the plastic strips), or pushpins (through the white
plastic ends).

7 Skip the next section, “Installing the TV/FM Tuner Card in a
Modular Computer,” and go on to the section that follows,
“Connecting Other Video Equipment.”

FM antenna
(Attach the “T” in the position
that gives clearest reception.)



Installing the TV/FM tuner card in 
a modular computer

If your system has a separate monitor, like this one, continue
with the steps below. If the monitor is built into your system,
go back to the section that precedes this one, “Installing the
TV/FM Tuner Card in a Compact Computer.”

To install the TV/FM tuner card in a modular computer,
follow these steps:

1 Make sure you save any open documents and quit any open
applications. Then turn off the computer.

Choose Shut Down from the Special menu.

2 Unplug all the cables except the power cord from your
computer.

Leaving the power cord plugged in helps protect 
the computer from electrostatic discharge damage.

Important To avoid generating static electricity that may
damage the card or computer, do not walk around the room
until you have completed the installation of the card and
closed the computer. Additionally, move the logic board as
little as possible while it is outside the computer.
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27Installing the Card and Software

3 Use a screwdriver to unscrew the access cover for the TV/FM
tuner card port.

4 Remove the access cover by pulling it toward you.

You won’t have to replace the access cover after you’ve
installed the TV/FM tuner card, but you will need the screws.
Store the access cover; you may want to put it back on if you
ever remove the TV/FM tuner card.

5 Remove the TV/FM tuner card from its static-proof bag.

Remove both screws and the access cover.
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6 Reach into the access hole you just uncovered and gently
pull out the ribbon cable.

7 Insert the ribbon cable plug into the connector on the back
of the card.

Connector

Ribbon cable plug

Gently pull the ribbon cable a short
way out of the opening so that you
can attach it to the card. 

Ribbon cable



8 Gently slide the card into the access hole, with the ribbon
cable on the side of the card that’s facing down.

Be sure that all the ribbon cable goes into the access hole.

9 Screw the TV/FM tuner card to the computer.

To do this, use the screws you removed in step 3.

Reinsert both screws.

Make sure the TV/FM tuner
card slides into the guides
that are on both sides of
the opening.
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Making connections to the TV/FM tuner card

After installing the TV/FM tuner card by attaching the card to
the computer, you then attach an FM antenna and a TV
antenna (or cable service connection) to the card.

To attach FM and TV connections to the card, follow these
steps.

1 Turn off the computer if it isn’t already off.

Choose Shut Down from the Special menu.

2 Attach the provided FM antenna to the FM port—the port on
the left, marked by the icon. Depending on the type of
antenna that came in your package, you may have to either
push or screw the connector onto the FM port.

FM antenna

Attach the FM antenna
to the FM tuner port. The
FM tuner port is marked
with the      icon.
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3 Before you attach the TV cable, make sure it has an F-type
coaxial cable connector. 

Important Do not attach or detach the coaxial cable while
the computer is turned on.

Note: If you want to view closed captions on a videotape
that has them, you must connect the VCR to the TV/FM
tuner card, not the video input card. For instructions on how
to do this, see the Appendix, “Viewing Closed Captions on
Videotape.”

F-type coaxial cable connectors
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4 Using an F-type coaxial cable connector, connect the TV port
on the right, marked by the icon, to a cable service or to
an antenna.

Coaxial cable from an external TV antenna or cable TV service

Attach the coaxial cable
to the TV tuner port. The
TV tuner port is marked
with the      icon.
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5 Reconnect the power cord and any cables you disconnected
at the start of this process.

6 Unfold the FM antenna and position it high for the best
reception.

Attach the antenna to a wall in the position that gives the
clearest reception. Use tape, thumbtacks (through the
middle of the plastic strips), or pushpins (through the white
plastic ends).

FM antenna
(Attach the “T” in the position
that gives clearest reception.)
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Connecting other video equipment

If you want to see video on your computer from a VCR, laser
disc player, video camera, or other video equipment, you
need to connect the equipment to the ports on the video
input card in your computer.

You can connect one piece of equipment to the S-video 
port or one piece to the composite video port on the video
input card. 

Note: You can also connect two pieces of video equipment
to the video input card simultaneously—one to the S-video
input port on the card and another to the composite video
input port on the card. For example, you can view a
recording from a video camera connected to the S-video port,
then switch—using the Apple Video Player application,
without having to disconnect cables—to viewing video from a
VCR connected to the composite port on the card. However,
you will hear sound only from that piece of equipment that is
connected to the audio input ports on the card.

Preparing to connect video equipment

Before you start, make sure that 

m both the Macintosh and the video equipment are turned off

m you place the video equipment near enough to your
Macintosh for easy connection

m you determine which type of video connector you need for
your video equipment (see the next section)
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Determining which video connector 
you need

Check the video out port or ports on your video equipment.
A video out port should look like one of the ports pictured
below. (You may have both ports.)

To connect to a composite video out port, use a composite
(RCA plug) connector. See “Connecting Video Equipment If
You Use a Composite (RCA Plug) Video Connector.”

To connect to an S-video video out port, use an S-video
connector. See “Connecting Video Equipment If You Use an
S-video Connector.”

S-video connector

Composite connector (RCA plug)

S-video port Composite video port (RCA-type)
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Connecting video equipment if you use 
a composite (RCA plug) video connector

To connect your video equipment you need one video cable
and two audio cables, all with RCA plugs at both ends. The
cables can be separate or joined. You can purchase cables at
electronics supply stores.

Note: If you have only one audio out port on your video
equipment, you can use a Y-adapter audio cable. This cable
has a single plug on one end to plug into your equipment
and a double plug (where it forms a Y) on the other end to
plug into the two audio ports on the video input card.

RCA RCA

RCA RCA

RCA RCA

or

RCA RCA

RCA RCA

or

RCA

video

audio

audio

2 audio

video

2 audio

video

RCA
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1 Make sure that both the Macintosh and the video equipment
are turned off.

2 Attach one end of the video cable to the video out port on
the video equipment.

3 Plug the other end of the video cable into the yellow
composite video input port on the video input card.

4 Insert the RCA plugs on one end of the audio cables into the
left and right audio out ports on the video equipment.

If you’re using a Y-adapter audio cable: Plug the single
end of the cable into the audio out port on your video
equipment.

5 Insert the RCA plugs on the other end of the audio cables
into the left (white) and right (red) sound input ports on the
video input card. 

Be sure to plug the cable from the left audio out port on the
video equipment to the left sound input port on the
computer. Connect the right ports in the same way.

If you’re using a Y-adapter audio cable: Plug the double
end of the cable (where it forms a Y) into the right and left
sound input ports on the video input card.
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The video input card ports are exactly the same on a
computer with a built-in monitor, and the card itself is in
about the same position on the back of the unit as in the
illustration below of a computer without a built-in monitor.

Your video equipment is now connected to the video 
input card.

Video input port (yellow)

Left sound input port (white)

Right sound input port (red)

Video out port

Left audio out port

Right audio out port

The ports on your video equipment may be arranged
and labeled differently from those shown here.

Cables with
RCA plugs
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Connecting video equipment if you use an 
S-video connector

To connect your video equipment you need one video cable
with S-video connectors on both ends and two audio cables
with RCA plugs at both ends. The RCA cables can be separate
or joined. You can purchase cables at electronics supply
stores.

Note: If you have only one audio out port on your video
equipment, you can use a Y-adapter audio cable. This cable
has a single plug on one end to plug into your equipment
and a double plug (where it forms a Y) on the other end to
plug into the two audio ports on the video input card.

RCA RCA

RCA RCA

S-video S-video

RCA

audio

audio

2 audio
RCA

S-video S-video

or
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1 Make sure that both the Macintosh and the video equipment
are turned off.

2 Attach one end of the video cable to the video out port on
the video equipment.

3 Plug the other end of the video cable into the S-video input
port on the video input card.

About the S-video port: The S-video port accepts 4-pin and
7-pin connectors.

If the connector doesn’t slide easily into the port, realign it
and try again. Avoid using force, which could damage the
card or the connector.

4 Insert the RCA plugs on one end of the audio cables into the
left and right audio out ports on the video equipment.

If you’re using a Y-adapter audio cable: Plug the single
end of the cable into the audio out port on your video
equipment.

5 Insert the RCA plugs on the other end of the audio cables
into the left (white) and right (red) sound input ports on the
video input card. 

Be sure to plug the cable from the left audio out port on 
the video equipment to the left sound input port on the
computer. Connect the right ports in the same way.

If you’re using a Y-adapter cable: Plug the double end of
it (where it forms a Y) into the right and left sound input
ports on the video input card.
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The video input card ports are exactly the same on a
computer with a built-in monitor, and the card itself is in
about the same position on the back of the unit as in the
illustration below of a computer without a built-in monitor.

Your video equipment is now connected to the video 
input card.

S-video cable

Cables with
RCA plugs

S-video port (7-pin)

Right sound input port (red)

Left sound input port (white)

S-video port (4-pin)

The ports on
your video

equipment may
be arranged
and labeled

differently from
those shown here.

Right audio out port

Left audio out port
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Installing the software

To play TV and FM radio you use two separate applications.
The Apple Video Player application lets you watch TV and
video on your computer; the Apple FM Radio application lets
you listen to FM radio on your computer.

Note: If you already have a version of Apple Video Player
on your computer, the installer disks in this package
automatically replace that version with the latest version of
Apple Video Player at the same time that they install the
Apple FM Radio application.

To install the Apple FM Radio and Apple Video Player
application programs, follow these steps.

1 Start the computer.

2 Insert the floppy disk, TV/FM Software Install Disk 1, into
the floppy disk drive.

3 Double-click the disk icon to open it.

4 Double-click the Installer icon.
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5 Click Install.

6 Follow the instructions on the screen.

The instructions on the screen tell you when you need to
insert the next software installer disk.

7 When the installation is complete, click Restart.

You can now find two separate folders in your Apple Extras
folder on your hard disk—one for the Apple FM Radio
application and one for the Apple Video Player application,
with the icons for the applications inside the appropriate
folders.

These are the icons for the applications:
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Where to go from here

The TV/FM tuner card is preset to display TV shows from
broadcast TV and to receive FM radio broadcasts.

If you want to listen to the radio

m To begin listening to the radio immediately, turn to 
Chapter 2, “Listening to the FM Radio.”

m To preset your favorite stations or to set the radio to 
receive only the strongest station signals, see Chapter 3,
“Customizing the FM Radio Settings.”

m To learn how to save radio recordings on your computer,
see Chapter 4, “Recording from the Radio.”

If you want to watch TV or video

m To begin watching TV or video immediately, turn to 
Chapter 5, “Watching TV or Video.”

m To switch the source of the TV signal from antenna to cable
service, see “Choosing a Connection (Antenna or Cable
Service)” in the section “Programming Channels” in 
Chapter 6.

m To customize TV tuner features in the way that best fits your
viewing habits, see Chapter 6, “Customizing the TV Tuner
Settings.”

m To learn how to capture individual images or whole movie
sequences, see Chapter 7, “Capturing TV and Video Images.”
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This chapter contains most of the information you need to
use the Apple FM Radio application program to listen to FM
radio on your computer.

You may find listening to the radio more convenient if you
first set up some of the options discussed in Chapter 3,
“Customizing the FM Radio Settings.” 

See also: Chapter 9, “Using the Remote Control.”
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Turning on the FM Radio

To turn on the radio, open the Apple FM Radio application
program by double-clicking its icon. (The application is in
the Apple FM Radio folder, in the Apple Extras folder on
your hard disk.)

When the Apple FM Radio application opens, a window
appears and the radio comes on. (You may hear only static
until you tune in a clear station.)

If you do not hear the radio right away, see the section
“Problems Listening to the Radio,” in Chapter 10.

Note: If you get a message telling you to select TV as the
video source in Apple Video Player, do that. If you need
help, see the section “Choosing a Video Source” in 
Chapter 5.
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Turning off the FM radio

To turn off the FM radio, open the File menu and choose
Quit.

Getting help on screen

If while using the Apple FM Radio application you become
stuck or forget how to do a task, on-screen help may be
available. Make sure that the FM Radio window is active,
then go to the menu at the upper-right corner of the screen,
marked with theh icon, and choose Apple FM Radio Guide.

Note: Apple FM Radio Guide is not available if you have a
computer with system software earlier than 7.5.

To see explanations of all the items on the screen when you
use Apple FM Radio, make sure that the FM Radio window is
active, then choose Show Balloons from the hmenu.
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Tuning in to stations

You can tune in to stations with the Apple FM Radio
application much as you would with any radio—by pressing
one of the tuning arrows or one of the six Preset Station
buttons on the left (after you have assigned stations to
them). The frequency number of the station you are playing
is displayed.

To learn how to assign preset stations, see “Presetting
Stations” in Chapter 3.

Seeking stations

To tune in to only the clearest stations, click the Up or Down
arrows under Seek. The radio stops at each of the clearest
stations it receives.

Note: The FM tuner is preset to search all stations for the
clearest signals. However, you can set the tuner so that it
searches for clear stations within a certain signal range or
strength. For example, you can preset the tuner to scan only
local signals or to scan all but the weakest signals. See
“Setting Signal Range and Strength” in Chapter 3.

To automatically assign the clearest stations to the Preset
Station buttons, see “Presetting Stations Automatically” in
the section “Presetting Stations,” in Chapter 3.
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Stepping through all stations

To tune in to all available stations (whether or not they come
in clearly), click the Up or Down arrows under Step. To cycle
through the stations more rapidly, place the pointer on one
of the arrows and hold down the mouse button.

Adjusting the sound

You can adjust the FM radio’s volume and set the radio to
receive stereophonic (stereo) or monophonic (mono)
sound. The sound adjustments you make take effect
immediately, so you can monitor your changes.

Changing the sound’s volume

There are four ways to change the volume.

m Use the volume buttons on the front of the computer.

m Drag the slider next to the speaker icon on the FM Radio
window. (You can also click anywhere in the slider’s track to
move the slider to that position.)

m Press the Up Arrow key or Down Arrow key on the keyboard.

m Use the volume controls on the remote control. See 
Chapter 9, “Using the Remote Control.”
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Selecting stereo or mono sound

The Apple FM Radio is preset to play sound in stereophonic
(stereo) sound if the station broadcasts in stereo. Some
stations come in more clearly if you select monophonic
(mono) sound. To select stereo or mono sound, follow
these steps.

1 Open the Options menu and drag to the Sound choice.

A pop-up menu appears beside the Sound choice.

2 Select Stereo to receive stereo sound or Mono to receive
mono sound. 

The selected sound mode has a checkmark beside it.
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This chapter explains how to use the Apple FM Radio
application program to give names to stations, to preset
stations you want to listen to most frequently, and to set the
signal range and strength of the stations you want to receive.

You’ll need to turn on the FM Radio before following the
instructions in this chapter. To turn on the FM Radio, open
the Apple FM Radio application by double-clicking its icon.
(The application is in the Apple FM Radio folder, in the
Apple Extras folder on your hard disk.)

Customizing is optional: The information and instructions
provided in this chapter are meant to make using your Apple
FM Radio more convenient. You don’t have to customize the 
Apple FM Radio to listen to the radio on your computer. For
the basic information you need about listening to the radio,
read Chapter 2.
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Presetting stations

This section describes how to preset stations so you can
tune them in quickly.

Tuning in to preset stations

After you assign preset stations, there are three ways you can
tune them in:

m Press a Preset Station button in the FM Radio window.

m Choose a preset station from the pop-up menu next to the
frequency of the current station in the FM Radio window.
The pop-up menu lists preset stations in numerical order for
easier reference.

m Press one of the buttons in the Preset Stations window
(chosen through the Options menu).
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Assigning stations to the Preset Station
buttons

To specify your favorite station as a preset station, follow
these steps:

1 Tune in to the station you want to preset. (See “Tuning In to
Stations” in Chapter 2.)

The station is displayed in the lower-left corner of the FM
Radio window.

2 Use one of the following methods to assign the station to 
a button:

m Place the pointer on a Preset Station button, then hold
down the mouse button until you hear a beeping sound.
The current station’s frequency appears on the button.

m Place the pointer on the station’s frequency, drag it from
the box onto one of the six Preset Station buttons, then
release the mouse button. (Note: This method works only
if you have system software version 7.5 or later.)
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m Open the Options menu and choose Add Preset Stations.
When the Preset Stations window appears, move it away
from the FM Radio window so that you can see both
windows clearly. Place the pointer on the station’s frequency
and drag it from the box onto one of the rows in the Preset
Stations window. When the row highlights, release the
mouse button.

This method lets you preset more than six stations.

Note: The first six rows in the Preset Stations window
represent the six buttons in the FM Radio window.

54 Chapter 3



m In the Preset Stations window, type in the frequency of the
station you want assigned to that row. 

Note: If you just type the station’s call letters (usually four
capital letters) and not the frequency, the station won’t be
assigned as a preset station. You must type in the frequency
because the frequency is what the FM tuner uses to find the
station.

You can also type in the station’s call letters and your own
description, although they’re not required. To display this
information on the Preset Station buttons, see “Labeling
Preset Station Buttons” later in this section.

3 Click on the pop-up menu (the arrow next to the current
station’s frequency in the FM Radio window) to see the list
of all stations you have preset. You can use this menu to
choose a preset station to listen to.

If you want to make changes to the Preset Station buttons,
see “Changing Preset Stations” later in this section.
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Presetting stations automatically

When you preset stations automatically, the Apple FM Radio
application automatically assigns the clearest stations to the
first available rows in the Preset Stations window, after
stations that have already been assigned. (The added
stations also appear in the pop-up menu list in the FM Radio
window.)

Note: The Apple FM Radio application is set to search all
stations for the clearest signals when automatically adding
stations. You may want to search for stations within a certain
signal range or strength. If you want to do this, see the
section “Setting Signal Range and Strength” later in this
chapter before you continue with these instructions.
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To preset the clearest stations by adding them automatically,
follow these steps.

1 Open the Options menu and choose Add Preset Stations.

The Preset Stations window appears. 

If you’ve preset stations already, they appear in the rows.

2 Click Auto Add.

The FM tuner adds the clearest stations to the rows in the
Preset Stations window and to the pop-up menu in the FM
Radio window. If you’ve preset some stations already, Auto
Add adds to the list in the Preset Stations window; it does
not override stations you have already preset. The stations
added appear in numerical order after the stations that were
already preset.

If you want to make changes to any of your preset stations,
see “Changing Preset Stations” later in this section.
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Labeling Preset Station buttons

The Apple FM Radio application automatically displays
stations’ frequencies on the six main Preset Station buttons
when you assign stations to them. But you can also display
stations’ call letters or descriptions on the buttons (or
display simply the numbers 1 through 6 on the buttons).

To display call letters, descriptions, or numbers on the
Preset Station buttons, follow these steps:

1 Make sure that you have typed in call letters or descriptions
for the stations in the Preset Stations window.

2 Open the Options menu and choose Preferences.

3 In “Type of Info shown,” click in the circle next to one of the
following:

m Numbers—if you want the Preset Station buttons to be
numbered in order, 1 through 6

m Frequencies—if you want station frequencies (for example,
102.1) to appear on the Preset Station buttons
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m Call Letters—if you want the stations’ call letters to appear
on the Preset Station buttons (usually the call letters are four
capital letters, such as WABC)

m Descriptions—if you want your own description of the
station to appear on the Preset Station buttons. (Only the
first four to six characters of the description appear on 
the button.)

Changing preset stations

There are several ways to change the stations you’ve preset.

m To change a station in the preset stations list, click in the
frequency column of the row you want to change, and type a
new frequency label.

Remember: You must type in the frequency because the
frequency is what the FM tuner uses to find the station. You
can also change the call letters and description.

m To add the current station to the list, drag its frequency onto
any button in the FM Radio window or to a row in the Preset
Stations window.

m To move a preset station to a different button or place in the
list, drag an entire row on top of another row in the Preset
Stations window.

m To clear a row (delete its contents), click anywhere in the
row and then click Clear Row.

m To undo all changes you just made to the Preset Stations
window (since you last opened it), click Revert.
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Setting signal range and strength

You can set your FM radio so that it searches within a certain
signal range or strength for the clearest signals whenever
you use the Seek or Auto Add features. 

Choosing signal range

You can select the area—wide or local—from which Apple
FM Radio receives stations. The Apple FM Radio is preset to
receive whatever stations it can pick up, but you may
sometimes want to choose a local range to reduce
interference from strong neighboring stations (stations that
are not local).

To choose the range of the signals in which the FM tuner
searches, follow these steps:

1 Open the Options menu and choose Signal Range.

2 Choose DX to receive any station the radio can pick up.
Choose Local to receive only local stations. 

A checkmark appears beside the range that is selected.
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Choosing signal strength

By choosing a signal strength, you can set the Apple FM
Radio to seek or to automatically add stations that send
signals of a certain strength. For example, if you set the
signal strength to Strongest Only, the Apple FM Radio will
seek or automatically add fewer stations than if you had set
the signal strength to All Stations.

To choose the signal strength that the Apple FM Radio
application looks for when it seeks or adds stations, follow
these steps:

1 Open the Options menu and choose Signal Strength.

2 Choose the signal strength you want.

The signal strength you choose affects how many stations
come up when you use the Seek or Auto Add features.
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Setting other preferences

Besides selecting the type of station information you want to
have appear on the Preset Station buttons, you can also
choose the color in which the currently playing station’s
frequency is displayed, and whether or not you hear an alert
sound as a confirmation when you preset a new station. 

To learn how to change the compression/sample rate of any
recordings you make, see the section “Compressing
Recordings” in Chapter 4, “Recording from the Radio.”

m To change the color of the text displaying the frequency of
the current station, open the Options menu and choose
Preferences. Click on the pop-up menu next to Color of
Current Station Text and select the color you want.

Note: Whatever station is currently playing is always
displayed in red in the Preset Stations window. The color
you choose only changes the frequency of the current
station displayed at the lower left in the FM Radio window.
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m To turn off the beep you hear when a new station is
successfully preset, click in the Audio Confirmation of
Presets box to remove the X.

After you’ve finished selecting your preferences, click OK to
implement the changes. (The window then closes.)

m To undo any changes you made since you last opened the
Preferences window, click Reset.
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This chapter gives instructions for using the Apple FM Radio
application to record radio sound onto your computer’s
hard disk. It also gives instructions for compressing
recordings so that they take up less disk space. You can play
back recordings with the SimpleText application, which uses
QuickTime technology to play back sound.

You’ll need to turn on the radio before following the
instructions in this chapter. To turn on the radio, open the
Apple FM Radio application program by double-clicking its
icon. (The application is in the Apple FM Radio folder, in 
the Apple Extras folder on your hard disk.)
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Compressing recordings

Before you record, you may want to choose a compression
rate for your recording. Recordings that are not compressed
have high-quality sound, but they take up a lot of disk space.
If you compress a recording, it takes up less disk space but
the recording sounds less clear than the original when you
play it back.

To compress recordings, follow these steps before you
record:

1 Open the Options menu and choose Preferences.

The FM Radio Preferences window appears.

2 In the Compression/Sample Rate box, choose the
compression rate you want by dragging the slider towards
“Least disk space” or “Highest Quality.”

A compression rate of 1:1 means that no compression takes
place. A compression rate of 3:1 uses a third of the disk
space that 1:1 uses. A compression rate of 6:1 saves the most
disk space.
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Remember: Compression affects the sound quality of your
recording: the more compression you use, the less clear
your recording sounds.

You can also click anywhere in the track to move the slider.

Note: The compression ratios possible for your computer
may be different from those possible for other computers.
(As a result, you might not be able to move the slider to
certain positions on the slider bar.)

3 Click OK.

The compression rate you just chose remains in effect for all
recordings until you change the compression rate in the FM
Radio Preferences window again.

Saving recordings

You can record from the radio any time by pressing the
Record button in the FM Radio window. 

To record from the radio and save it on a disk, follow 
these steps.

1 Choose a compression rate for your recording, if you want to
and haven’t done so already. See the previous section,
“Compressing Recordings.”
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2 Click the Record button in the FM Radio window.

Immediately, the Record button turns into a Stop button and
red light, and a “Recording time” counter appears that tells
you the length of time that has passed since you clicked
Record.

3 Click Stop when you want to stop recording.

Important If you don’t click the Stop button, recording
continues until the hard disk is full. 
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The Save Audio Recording dialog box appears.

4 Specify a name for your recording and the location where
you want to save it.

You can also play back a recording and adjust the recording’s
volume before you save it, using the Playback bar. Click the
play (.) button to play it back and the sound (-) button to
adjust the volume.

5 Click Save.

When you open the recording later (by double-clicking its
icon), it opens as a SimpleText document, which uses
QuickTime technology to play back the sound at the volume
level at which you saved it.
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This chapter contains most of the information you need to
use the Apple Video Player application program to watch TV
or video on your computer. You also use Apple Video Player
to watch video (from a VCR or video camera, for example)
on your computer.

You may find watching TV more convenient if you first set
up some of the options discussed in Chapter 6,
“Customizing the TV Tuner Settings.” 

See also:  “Setting the Closed Caption and Video Text
Options” section in Chapter 8 and Chapter 9, “Using the
Remote Control.”
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Opening Apple Video Player

To use the Apple Video Player application program, open 
it by double-clicking its icon. (The application is in the 
Apple Video Player folder, in the Apple Extras folder on your
hard disk.) You can also press the TV/MAC button on the
remote control. 

When the Apple Video Player application opens, a video
window appears. You can watch video or TV in the 
video window.

If you don’t get an image in the window right away, see
Chapter 10, “Troubleshooting.”
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Getting help on screen

On-screen help for the Apple Video Player application is
available through the menu at the upper-right corner of 
the screen, marked with the h icon. When Apple Video
Player is the active application, choose Apple Video Player
Guide from the hmenu. Apple Video Player Guide gives
you step-by-step instructions for tasks you need help doing.

Note: Apple Video Player Guide is not available if you have
a computer with system software earlier than 7.5.

To see explanations of all the items on the screen when you
use Apple Video Player, make sure that the video window is
active, then choose Show Balloons.

73Watching TV or Video



To be reminded of keyboard shortcuts you can use with
Apple Video Player, choose Apple Video Player Shortcuts
from the hmenu.

Using a hot key

You can also open the Apple Video Player application by
pressing a “hot key” (a preset key or combination of keys).
When you press this hot key, you switch to the Apple Video
Player program no matter what computer program you 
are currently in. To learn how to set a hot key, see “Setting a
Hot Key” in Chapter 6.
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Choosing a video source

Using the Apple Video Player application, you can either
view TV signals that come through a cable or an antenna, or
watch a video recording from a VCR or other video device.

To choose a video source setting, follow these instructions:

1 Open the Windows menu and choose Show Controls
Window.

The Controls window appears.

2 Click the video screen icon.

The screen controls appear.
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3 Click the video source you want to use:

m If you want to watch TV, click TV.

m If you want to view video from a VCR or other device
that’s attached to the composite video input port, click
Video.

m If you want to view video from a VCR or other device
that’s attached to the S-video input port, click S-Video.

Note: If you’re not sure which port a video device is
attached to, see “Determining Which Video Connector You
Need” in the section “Connecting Other Video Equipment”
in Chapter 1.

The source change takes effect as soon as you make your
choice.

Changing TV channels

When the video source is set to TV and the video window is
active, you can use any of the following methods to change
channels:

m Click the Up or Down arrow on the video window.

m Select a name from the Names pop-up menu on the video
window (if you’ve given names to channels, as described in
Chapter 6).

m Press the Left Arrow key or Right Arrow key on the keyboard.
(Make sure Apple Video Player is the active application, or
these keys won’t have any effect.)
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m Type the channel number.

When you use an arrow, you go to the next available
unlocked channel (a channel with unrestricted access). To
go to a locked (restricted access) channel, you must enter a
channel number.

Note: See “Locking and Unlocking Channels” in Chapter 6
to learn how to restrict or grant access to channels.

To go back and forth between the current channel and the
last one to which you were tuned, press the Tab key.

Each time the channel changes, the channel name (if one
exists) appears briefly on top of the TV picture.

m Use the channel controls on the remote control. For more
information, see Chapter 9, “Using the Remote Control.”

Too many channels? When you browse through channels
using the remote control or the arrows on your keyboard or
video window, you may see channels that have no picture or
that show only static. To skip such channels entirely, see
“Programming Channels” in Chapter 6.

Adjusting the sound

You can adjust the sound’s volume, balance, and tone. You
can also choose monophonic (mono) or stereophonic
(stereo) sound.

Changing the sound volume

There are four ways to change sound volume:

m Use the volume buttons on the front of the computer.

m Drag the slider next to the speaker icon on the video
window.
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m Press the Up Arrow key or Down Arrow key on the keyboard.
(Make sure Apple Video Player is the active application, or
these keys won’t have any effect.)

m Use the volume controls on the remote control. For more
information, see Chapter 9, “Using the Remote Control.”

To mute the sound, click the speaker on the video window,
pressx-M on the keyboard, or press the muting button on
the remote control. To turn the sound back on, click the
speaker, press x-M, or press the remote control’s muting
button. The sound will also go back on if you adjust the
volume using any method.

You can also click anywhere in a slider’s track to move the
slider to that position. The sound adjustments take effect
immediately, so you can monitor your changes.

Choosing a sound mode

When the video source is set to TV, you can control whether
the sound is mono or stereo. You can also choose the
Second Audio Program (SAP), which (when available)
broadcasts in a second language.

To set the sound mode, follow these steps:

1 Choose Show Controls Window from the Windows menu.

The Controls window appears.

2 Click the sound icon.
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The sound controls appear.

3 Click the sound mode you want to use (Mono, SAP, 
or Stereo).

The new mode takes effect immediately.

Adjusting speaker balance and tone

To adjust the speaker balance, bass, or treble:

1 Choose Show Controls Window from the Windows menu.

2 Click the sound icon.

3 Drag the appropriate slider to adjust the sound to your
liking.

You can also click anywhere in a slider’s track to move the
slider to that position. The sound adjustments take effect as
you make them, so you can monitor your changes.

Note: You’ll only be able to hear changes in balance if
you’re using external speakers or headphones.
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Adjusting the picture

To adjust the brightness, sharpness, contrast, and color of
the picture:

1 Choose Show Controls Window from the Windows menu.

The Controls window appears.

2 Click the video screen icon.

The screen controls appear.

3 Drag the appropriate slider to adjust the picture to your
liking.

You can also click anywhere in a slider’s track to move the
slider to that position. The picture adjustments take effect as
you make them, so you can monitor your changes.
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This chapter explains how to use the Apple Video Player
application program to give names to channels, protect
channels with a password, and set reminders that notify you
when important shows are about to begin.

Before following the instructions in this chapter, you need to
open the Apple Video Player application by double-clicking
its icon. (The application is in the Apple Video Player folder,
in the Apple Extras folder on your hard disk.) You can also
press the TV/MAC button on the remote control.

The information and instructions provided in this chapter
are meant to make using your TV tuner more convenient.
You don’t have to customize the TV tuner to watch
television on your computer, but if you don’t you’ll only be
able to see a few channels. For the basic information you
need about watching TV or video, read Chapter 5.

See also: “Setting the Closed Caption and Video Text
Options” in Chapter 8.
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Programming channels

Your TV tuner card can receive channels picked up by your
antenna connection (channels 2 through 69) or cable service
connection (channels 1 through 125).

You can make changes to the list of channels that are
available with a particular connection. First, you choose a
connection; then you can edit the channel list for that
connection.

Choosing a connection (antenna or 
cable service)

To choose a connection so that you can edit its channel list,
follow these steps:

1 Choose Channel Setup from the Setup menu.

The Channel Setup window appears, with the channel list in
a scrollable box.
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2 Open the Connection pop-up menu (under the channel list).

3 Choose the connection you want.

The channel list changes to a list of channels available with
that connection.

About HRC Cable: Some cable services use HRC cable
frequencies instead of standard cable frequencies. If you
can’t receive channels above channel 13, try selecting HRC
Cable in the Connection pop-up menu. 

Removing channels automatically

Some channels in a channel list don’t have valid signals. 
You can remove such channels from the list so that they’re
skipped when you scan through the channels.

To remove channels automatically, click the Auto Tune
button. Auto Tune finds valid channels and “disables” the
rest, removing them from the channel list.

Note: Auto Tune removes invalid channels only from the
channel list for the connection selected in the Connection
pop-up menu. You may want to choose each of the other
connections and click Auto Tune to remove channels in 
each channel list.

Once a channel is removed, you can still get to it by typing
its number on the keyboard. You can also make a channel
available again by adding it to the channel list manually. See
“Restoring and Adding Channels” later in this section.
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Removing channels manually

Although Auto Tune filters out channels that don’t send valid
signals, it doesn’t remove channels that send valid but
scrambled signals (for example, pay-per-view or premium
cable channels). Additionally, there may be channels in your
viewing area that you would simply prefer not to see when
you browse through channels.

Follow these steps to remove channels manually from
channel lists:

1 Choose Channel Setup from the Setup menu.

2 Choose from the Connection pop-up menu the connection
for the channel list you want to edit.

Note: You can remove channels only from the channel list
for the connection that’s currently chosen. For example, if
you remove channel 13 from the antenna channel list, it may
still be available in the Cable channel list or the HRC Cable
channel list.

3 Select the channels you want to remove.

To select several channels in a row, hold down the Shift key
and drag. To select channels scattered throughout the list,
hold down the Shift key and click each channel you want
removed.

You may have to scroll to see all possible choices.

4 Click Remove.

The channels you selected are removed from the channel
list.
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Locking channels: You may want to keep a channel in the
channel list, but restrict access to it. See “Locking and
Unlocking Channels” and “Creating and Changing a
Password” later in this chapter.

Important If you want to use Auto Tune, do so before you
manually add or remove channels. You can use Auto Tune
after you’ve added and removed channels, but doing so
undoes all your previous changes.

Restoring and adding channels

You may want to put a channel back on a channel list—for
example, when a station that was temporarily off the air
resumes broadcasting. Or you may want to add a channel—
for example, when your local cable company adds a new
station to its lineup.

Follow these steps to restore or add a channel to a channel
list:

1 Choose Channel Setup from the Setup menu.

2 Choose from the Connection pop-up menu the connection
for the channel list you want to edit.

Note: You can restore or add channels only in the channel
list for the connection that’s currently chosen. For example,
if you add channel 36 to the antenna channel list, it may still
not be available in the Cable channel list or the HRC Cable
channel list.

3 Click Add.

The Add Channels dialog box appears. If the Add button is
dimmed, all possible channels for the currently selected
signal source are already available.
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4 Select the channels you want to restore or add.

To select several channels in a row, hold down the Shift key
and drag. To select channels scattered throughout the list,
hold down the Shift key and click.

You may have to scroll to see all possible choices.

5 Click Add.

The channels you selected are added to the channel list.

Giving names to channels

You can assign a name of up to 15 characters to a channel.
The name can be the station’s call letters, network affiliation,
network name, or anything else you want.

Channel names appear in the Names pop-up menu of the
video window. See “Changing TV Channels” in Chapter 5 for
information on using a name to select a channel.

Follow these steps to name or rename channels.

1 Choose Channel Setup from the Setup menu.

2 Choose from the Connection pop-up menu the connection
for the channel list you want to edit.

Note: You can name or rename channels only in the
channel list for the connection that’s currently chosen. 
For example, if you give channel 13 a name in the antenna
channel list, the name will not appear in the cable channel
list or the HRC cable channel list unless you name it in 
those lists.
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3 Select a channel from the channel list, then click Edit Name.

Or, you can double-click the channel number or name.

The Edit Name dialog box appears, with any name already
assigned to the channel selected. (Initially, channels have no
names assigned to them.)

4 Type a name for the channel.

To remove a name from the channel, press the Delete key
while the entire name is highlighted.

5 Click OK.

The name you typed appears to the right of the channel
number in the channel list.
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Locking and unlocking channels

Locked channels appear in the channel list but don’t appear
in the video window when you scan through the channels.

1 Choose Channel Setup from the Setup menu.

2 Choose from the Connection pop-up menu the connection
for the channel list you want.

Note: You can lock or unlock channels only in the channel
list for the connection that’s currently chosen. For example,
if you lock channel 15 in the antenna channel list, the
channel will not be locked in the cable channel list or the
HRC cable channel list unless you name it in those lists.

3 Select the channels you want to lock by highlighting them.

To select several channels in a row, hold down the Shift key
and drag. To select channels scattered throughout the list,
hold down the Shift key and click all the channels you want
to lock.

You may have to scroll to see all possible choices.
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4 Click Lock.

The channels you selected are locked. Small locks appear at
the left of the locked channels’ numbers in the channel list.

You can watch a locked channel by typing its number on the
keyboard. A dialog box appears:

If you click Yes and no password is in effect, you tune in to
that channel. However, the channel remains locked and out
of the normal scanning sequence. If a password has been set,
you must type the password before the channel can become
available.

To unlock a channel, choose Channel Setup from the Setup
menu, select the channel, and click Unlock.
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Creating and changing a password

You can create a password to limit access to the Channel
Setup dialog box and locked channels. When you set a
password, anyone choosing Channel Setup from the Setup
menu or switching to a locked channel must type the
password.

The same password applies to all locked channels.

Creating a password

Follow these steps to create a password:

1 Choose Set Channel Password from the Setup menu.

A dialog box appears.
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2 Type a word or phrase of up to 15 characters.

You can also type a clue to help you remember the
password. The clue appears every time anyone seeking
access is asked for the password.

If you don’t want to have a clue, don’t type one.

3 Click OK.

Your password is now in effect.

Important Make sure you keep a record of your password.
If you forget your password, you will have to reset all your
customized settings (including channel names and
programmed channels) when you invalidate it, as described
in “Forgetting a Password,” later in this section.

Changing a password

Follow these steps to change a password:

1 Choose Set Channel Password from the Setup menu.

A dialog box appears.
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2 Type the current password.

If you’ve forgotten your password, see the next section,
“Forgetting a Password.”

As you type, the characters are replaced by bullets to ensure
privacy.

3 To change to a new password, click OK. Then follow steps 
2 and 3 in “Creating a Password,” earlier in this section.

To remove the password (so a password is not required),
make sure that the password in the Password text box is
selected (highlighted). Then press the Delete key before you
click OK.

Forgetting a password

If you enter an incorrect password, you see this dialog box:

If you can’t remember your password, you must reset the
password and then create a new one. 

To reset the password, quit the Apple Video Player
application. Then move the Apple Video Player Prefs file to
the Trash. The Apple Video Player Prefs file is in the
Preferences folder, which is in the System Folder.

Important When you move the Apple Video Player Prefs
file to the Trash, any preferences you have set (for example,
picture contrast or channel names) are changed back to the
standard settings provided by the Apple Video Player
application.
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Setting and editing TV reminders

You can arrange to have notices appear on your screen to
remind you that specific shows are about to begin.

When the time you’ve set for a reminder arrives, a notice
appears on the screen.

The notice appears no matter which application program
you are using on your computer at the notification time.

If you click OK in this notice, the Apple Video Player
application opens, switches to the proper channel, and
displays the show in the video window.

Setting a reminder

To set a reminder, follow these steps:

1 Choose TV Reminders from the Setup menu.

The TV Reminders dialog box appears.
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2 Click Add.

The Edit Reminder dialog box appears.

3 Type the show’s name as you want it to appear in 
the notice.

4 Set the day and time that the show begins.

5 Set the channel by typing its number in the Channel number
box.

If the channel has a name, you can select the name in the
pop-up menu to the right of the Channel number box.

6 Specify whether the reminder should occur on an ongoing
basis or just once.

If you select One Time Only, the reminder will be removed
automatically after the show airs.

7 If you want an advance notice before the show begins, type
the number of minutes before the show starts that you want
a warning; then click the “Warn me” checkbox to select it.

The notice can appear up to 99 minutes before show time.
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8 Click OK.

You’ll return to the TV Reminders dialog box, where you’ll
see your new entry in the list.

Editing a reminder

To edit a reminder, follow these steps:

1 Choose TV Reminders from the Setup menu.

The TV Reminders dialog box appears.

2 Select the reminder you want to edit, then click Edit.

Or, you can double-click the reminder.

The Edit Reminder dialog box appears.

3 Make the changes you want to, then click OK.

The changes you’ve made take effect immediately.

Removing a reminder

To remove a reminder, follow these steps:

1 Choose TV Reminders from the Setup menu.

The TV Reminders dialog box appears.

2 Select the entry you want to remove.

Important There is no Undo function for the Remove
command. To restore an entry that you have removed, you
must reenter all the settings you made in the Edit Reminder 
dialog box.

3 Click Remove.

The entry is removed immediately.

4 Click OK to close the TV Reminders dialog box.
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Setting a hot key

You can turn on the Apple Video Player application by
pressing a “hot key” (a preset key or combination of keys).
When you press this hot key, you switch to the Apple Video
Player application no matter what application you are
currently in. If the Apple Video Player is already the active
application, pressing the hot key quits the Apple Video
Player application. 

To set a hot key, follow these instructions:

1 Choose Hot Key from the Setup menu.

The Hot Key dialog box appears.

2 Press the key or key combination you want to use for your
hot key.

You can use one or more (up to four) of the modifier 
keys—x, Option, Control, and Shift—plus any other key.

Don’t use a key combination that is already used by other
programs. For example, don’t use x-P, which is for printing
in most programs.

3 Click OK.

Your new hot key is ready to use.

If you find that your hot key replaces a keyboard shortcut 
in another program, repeat these steps to choose another
hot key.
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This chapter gives instructions for using the Apple Video
Player application program to capture

m individual (still) images

m sequences of moving images (as QuickTime movies)

The images in the video window can come from the TV
tuner or from video equipment connected to your video
input card.

Before following the instructions in this chapter, you need to
open the Apple Video Player application by double-clicking
its icon. (The application is in the Apple Video Player folder,
in the Apple Extras folder on your hard disk.) You can also
press the TV/MAC button on the remote control.
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Capturing individual images

You have two ways to capture a single image—by using the
capture controls in the Controls window or by using the
Copy Video Display command in the Edit menu.

Capture controls

When you use the capture controls in the Controls window,
you can freeze the screen image before you save it.
Additionally, the capture controls let you save the image 
directly on a disk.

Follow these steps:

1 Choose Show Controls Window from the Windows menu.

The Controls window appears.

2 Click the video camera icon.

The capture controls appear.
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3 Wait until you see the image you want to capture.

The Controls window can remain open without affecting
what happens in the video window.

m To freeze the video image at the current frame, click Freeze.

The video freezes, and you can decide whether you want to
save the current frame.

To unfreeze the video, click Freeze again.

m To save the current video frame on a disk, click Save.

If the video isn’t already frozen, it freezes at the current
frame until you complete the Save operation. 

A dialog box appears so you can specify where to save the
image. When you click Save, the image is saved as a PICT file
under the name that you supply. (A PICT file can be opened
by most graphics applications.)

Copy Video Display command

To capture the current screen image by copying, choose
Copy Video Display from the Edit menu or press x-C.

Important When you use Copy Video Display or press 
x-C, the current screen image is copied to the Clipboard.
The image is not saved on a disk. (To save an image that’s 
on the Clipboard, you must paste it into a document or 
the Scrapbook.)
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Capturing movies

You can capture video sequences (moving images) as
QuickTime movies.

Video capture does not work as well with virtual memory 
on. For best results, turn off virtual memory. To check
whether it is on or not, open the Memory control panel. 
If the On button for virtual memory is selected, click the Off
button to turn virtual memory off.

To capture video images, follow these steps:

1 Make sure networking or printing is not active and virtual
memory is turned off.

For best results recording video, you should quit networking
or printing applications and turn off virtual memory. To
check whether virtual memory is on or not, open the
Memory control panel. If the On button for virtual memory
is selected, click the Off button to turn virtual memory off,
and restart your computer.

2 Adjust the volume to your liking.

Movies are captured at the current volume setting. For
example, if the sound is muted, your recorded movie will
not have any sound.

3 Choose Show Controls Window from the Windows menu.

The Controls window appears.
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4 Click the video camera icon.

The capture controls appear.

5 Wait until the sequence that you want to capture begins.

The Controls window can remain open without affecting
what happens in the video window.

6 Click Record.

Recording begins and the Record button changes to a 
Stop button.

7 Click Stop when you’ve recorded as much as you want.

Important If you don’t click the Stop button, recording
continues until the hard disk is full.

A dialog box appears, in which you can specify a name and
location for your movie.

You can also preview the QuickTime movie before you 
save it.
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Use as small a size as you can: The amount of disk
storage that a movie takes is directly related to the size of 
the video window—the larger the window, the more disk
space you use. By choosing Smallest Size from the Windows
menu before you record, you may be able to save more than
50 percent in storage space. (A movie that uses about 
75 megabytes per minute at the normal video window size
will use only about 35 megabytes per minute at the smallest
video window size.) See “Changing the Video Window Size”
in Chapter 8.

You can open the movie from within any application that
supports QuickTime, such as SimpleText. (QuickTime is a
system software extension that comes with your computer.)
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Using compression

With compression you can store movies in a much smaller
space than they would normally require. To use
compression, follow these steps before you record a movie:

1 Choose Preferences from the Setup menu.

The Preferences dialog box appears.

2 Click one of the buttons under Movie Compression.

None means that no compression takes place. Normal, the
preset choice, uses anywhere from 12 to 50 percent of the
disk space that None uses; the less movement in each frame
of the movie, the greater the savings. Most uses slightly less
disk space than does Normal.

To save the most space you can, choose the smallest size
video window and the most compression.

Note: Compression affects picture quality: the more
compression you use, the grainier the picture. 
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This chapter gives instructions for using the following special
features of the Apple Video Player application program:

m setting closed caption and video text options

m changing the size of the video window

m changing the color of the windows

m setting the video input standard (NTSC, PAL, or SECAM)

Before following the instructions in this chapter, you need to
open the Apple Video Player application by double-clicking
its icon. (The application is in the Apple Video Player folder,
in the Apple Extras folder on your hard disk.) You can also
press the TV/MAC button on the remote control.
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Setting the closed caption and video 
text options 

Some broadcast and cable TV programs feature closed
caption text tracks for people with impaired hearing. In
some areas, video text tracks that display programming
schedules, news, or financial data are available. When your
video source is set to TV, you may be able to take advantage
of special tracks.

Note: If you have a videotape with closed captions (for
example, if you’ve recorded a TV show with closed
captions), the captions can only be viewed if your VCR is
connected to the TV tuner card. (For instructions, see the
Appendix, “Viewing Closed Captions on Videotape.”)

1 Choose Show Controls Window from the Windows menu.

The Controls window appears.

2 Click the CC icon.

The closed captioning controls appear.
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3 Click the track you want to use.

CC 1 provides closed captions for most broadcasts that have
this feature. CC 2 sometimes provides captions in a second
language. Text 1 may provide schedules of programs
broadcast on a channel. Text 1 or Text 2 may provide
specialized text for TV.

The track you select applies to all channels, although some
channels may not provide the feature.

Changing the video window size

There are several ways to change the size of the video
window. You can choose a command from the Windows
menu, use a keyboard shortcut for one of the three most
common sizes, click the zoom box, drag the size box, or use
the remote control. (All but the last way are explained in this
section. The remote control is explained in Chapter 9.)

Choosing menu commands

You can choose different video window sizes from the
Windows menu:

m Smallest Size uses about 1/16 of the screen.

m Normal Size uses about 1/4 of the screen.

m Largest Size uses as much of the screen as it can.

On monitors that are 640 by 480 pixels or smaller, Largest
Size hides both the menu bar and the screen controls.
Moving the mouse makes the menu bar visible.
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m Other Size opens a dialog box in which you can enter the 
size you want.

Width must be in the range 160 to 640 pixels. Height must
be in the range 120 to 480 pixels.

Keep your proportions: The usual video window width-to-
height ratio is about 4 to 3. Setting other proportions
distorts the video image.

Using keyboard shortcuts and the zoom box

There are three keyboard shortcuts for changing the video
window size:

m x-1 sets the smallest size.

m x-2 sets normal size.

m x-3 sets the largest size.

To alternate between the current size and the largest size,
click the zoom box .
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Dragging the size box

If you drag the size box, the horizontal and vertical
dimensions of the screen change proportionally.

If you drag the size box while holding down the Shift key,
the image becomes distorted. (It stretches or shrinks in the
direction that you drag.)

Changing the window color

You can set a new color for the border surrounding the
video window by choosing Window Color from the Windows
menu. The current color is checked. The choices are Dark
Gray, Green, Blue, Magenta, Red, and Gold.

“Window Color” is not the display color:  The Window
Color command has no effect on the colors you see in the
video window. For information on setting the brightness,
sharpness, contrast, and color in the video window, see
“Adjusting the Picture” in Chapter 5.
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Setting the video input standard

The video input standard determines how the Apple Video
Player application interprets video signals. This standard is
preset to your region in the Apple Video Player software. In
most cases, you won’t need to change it.

NTSC is the standard video signal for most of the Americas
and Japan. PAL is common in Western Europe, Australia,
most of Asia, and parts of South America and Africa. SECAM
is used in France, Eastern Europe, and parts of Asia and
Africa.

To change the video input standard, follow these steps:

1 Choose Preferences from the Setup menu.

The Preferences dialog box appears.

2 Choose the Video Input Standard setting you need.

If the setting you choose produces a strange image (for
example, the picture is too small or the colors are odd), try
another setting.
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Before using the remote control, install the batteries that are
included in your package.

You can use your remote control to

m turn the computer on and off

m switch easily between watching TV or video, and using other
computer application programs

m control the sound of the radio or TV

m change TV channels or radio stations

m manipulate the size of the video window

If your computer has a CD-ROM drive, you can also use the
remote control to

m control the sound from an audio CD 

m stop and eject a CD or CD-ROM disc

m pause and continue play of an audio CD

m move to the previous track of an audio CD

m move to the next track of an audio CD
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Controlling your FM radio

Note: Your remote control may look different from the
one shown here, but it includes the same buttons.

Cycles among
the six main
preset stations

Turns muting
on and off

Turns the
computer on
and off

Adjusts volume
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You cannot use the remote control to switch to the Apple
FM Radio from another application. However, while you hear
the radio (whether or not the Apple FM Radio application is
open), the Apple FM Radio remote controls will work. 

When you press the TV/MAC button while the radio is
playing, the Apple Video Player application starts, but you
won’t hear the TV or video until you quit the Apple FM Radio
application.

If you are playing an audio CD in a CD-ROM drive, you hear
the audio CD and the TV or FM radio sounds simultaneously.
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Controlling TV or video

Note: Your remote control may look different from the
one shown here, but it includes the same buttons.

Switches between
the video window
and computer
programs

Changes
TV channels

Switches video
window between

current and
largest size

Turns muting
on and off

Turns the
computer on
and off

Adjusts volume
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Controlling your CD-ROM player

Note: Your remote control may look different from the
one shown here, but it includes the same buttons.

Goes to next
track on
audio CD

Goes to
previous track

on audio CD

Turns muting
on and off

Turns the
computer on
and off

Adjusts volume

Stops/ejects CD Plays/pauses CD
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Setting preferences

You can set two preferences for the remote control. The first
is whether the remote control is on or off, and the second is
whether a confirmation box appears when you press the
remote control’s Power button to shut down the computer.

1 Choose Preferences from the Setup menu.

The Preferences dialog box appears.

2 To turn off the remote control, click the Disable Remote
Control checkbox to put an X in it.

If this checkbox is selected, the remote control won’t work.
To turn the remote control back on, click the checkbox to
remove the X.

3 To make a confirmation box appear so you can change your
mind about shutting down the computer when you press
the remote control’s Power button, click the Confirm Power
Off checkbox to put an X in it.

If you no longer want to see the confirmation box, click the
checkbox to remove the X.

4 Click OK.

The changes take effect immediately.
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This chapter suggests what to do if problems occur when
you’re using the Apple Video Player or FM Radio software.

Warning If you have a problem with your Apple
equipment and nothing presented in this chapter or in the
documentation that came with your computer solves it,
consult the service and support information that came with
your Apple equipment for instructions on how to contact an
Apple-authorized service provider or Apple for assistance.

If you attempt to repair the Apple equipment yourself, 
any damage you may cause to the Apple equipment will 
not be covered by the limited warranty on your Apple
equipment. Contact an Apple-authorized dealer or service
provider for additional information about this or any other
warranty question.
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Problems listening to the radio

You can’t find the Apple FM Radio application.

If the Apple FM Radio application is not anywhere on your
hard disk, you need to install it.

You install Apple FM Radio from your system software CD,
system software disks, or the TV/FM Software installer disks,
depending on the disks or CDs you received with your
equipment.

1 Start the computer.

2 Insert the CD or disk that contains the Apple FM Radio
application.

m If you purchased your computer with the TV/FM tuner
card already installed, locate either the system software
CD or the set of system software floppy disks (whichever
came with your computer). If you have a system software
CD, insert it into the CD-ROM drive. If you have a set of
system software floppy disks, insert the first disk (labeled
something like Install Disk 1 or System Backup Disk 1)
into the floppy disk drive.

m If you purchased the Apple TV/FM Radio System kit
separately from your computer, insert the TV/FM Software
Install Disk 1 into the floppy disk drive.

3 Double-click the CD or disk icon to open it (if its window is
not already visible).

4 Double-click the Installer icon.
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5 Install the Apple FM Radio application.

m If you are installing from the TV/FM Software Install Disk 1
disk, click Install and follow the instructions on the screen.

m If you are installing from your system software CD or disks,
click Custom Install. Select Apple FM Radio from the
software list that appears, and then click Install.

The Apple FM Radio application is installed on your 
hard disk (in the Apple FM Radio folder in the Apple 
Extras folder).

6 When installation is complete, click Restart.

You don’t hear anything when you open the Apple
FM Radio application.

m Be sure your FM antenna is securely connected to the FM
port (the left port) on the TV/FM tuner card and the antenna
is raised high. See “Making Connections to the TV/FM Tuner
Card,” in Chapter 1, for your computer type.

m The radio sound doesn’t work if Video or S-Video is 
selected in the Apple Video Player application (even if that
application isn’t currently open). Open the Apple Video
Player application and choose Show Controls from the
Windows menu. Click the video screen icon (the second
button down on the left). Choose TV as your video source.
You can then quit the Apple Video Player application. 
Now when you open the Apple FM Radio application, you
will hear radio.
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m Be sure the volume on your computer is turned up. Use the
volume buttons on the front of your computer if you have
them, or use the sound-related control panel to adjust the
volume. (For more information on adjusting volume, see
Macintosh Guide if it is available on your computer, or the
printed manuals that came with your computer.)

m You may need to broaden the signal range or strength. Make
sure the Apple FM Radio application is active. Open the
Options menu, choose Signal Range or Signal Strength, and
choose “DX” for Signal Range and “All Stations” or “All
Except Weakest” for Signal Strength. For instructions on
choosing a signal range or strength, see Chapter 3,
“Customizing the FM Radio Settings.”

The reception is poor.

m Adjust the FM antenna (connected to the left port on the
TV/FM tuner card). Be sure it is securely connected to the
port and raised high.

The remote control doesn’t work.

m Make sure the remote control has a battery, or try changing
the remote control’s battery. 

m Try moving closer to your computer. If you are already very
close to the computer, point the remote control directly at
the remote control receiver on the front of the computer.

m The checkbox labeled Disable Remote Control may be
selected in the Preferences dialog box in your TV
application. Open Apple Video Player and choose
Preferences from the Setup menu. Deselect the Disable
Remote Control checkbox (click to remove the X).
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You can’t switch to radio using the remote
control, or quit the radio using the remote control.

m There isn’t a way to turn the radio on or off using the remote
control.

When you click Seek or Auto Add, Apple FM Radio
finds either too few or too many stations.

m If Apple FM Radio is finding too few clear stations, adjust the
FM antenna (the one connected to the left port on the
TV/FM tuner card) while the radio is playing to see if some
stations come in clearer.

m If Apple FM Radio is finding “fuzzy” stations when it scans or
adds stations, you may need to narrow the signal range 
or strength. Make sure the Apple FM Radio application is
active. Open the Options menu, choose Signal Range or
Signal Strength, and choose another setting. See what that
does to the Scan and Auto Add features. Experiment with
different settings to see which setting eliminates the 
stations you want eliminated. For instructions on choosing 
a signal range or strength, see Chapter 3, “Customizing the
FM Radio Settings.”
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Problems watching TV or video

You can’t find the Apple Video Player application

If the Apple Video Player application is not anywhere on
your hard disk, you need to install it.

You install Apple Video Player from your system software
CD, system software disks, or the TV/FM Software installer
disks, depending on the disks or CDs you received with your
equipment.

1 Start the computer.

2 Insert the CD or disk that contains the Apple Video Player
application.

m If you purchased your computer with the TV/FM tuner
card already installed, locate either the system software
CD or the set of system software floppy disks (whichever
came with your computer). If you have a system software
CD, insert it into the CD-ROM drive. If you have a set of
system software floppy disks, insert the first disk (labeled
something like Install Disk 1 or System Backup Disk 1)
into the floppy disk drive.

m If you purchased the Apple TV/FM Radio System kit
separately from your computer, insert the TV/FM Software
Install Disk 1 into the floppy disk drive.

3 Double-click the CD or disk icon to open it (if its window is
not already visible).

4 Double-click the Installer icon.
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5 Install the Apple Video Player application.

m If you are installing from the TV/FM Software Install Disk 1
disk, click Install and follow the instructions on the screen.

m If you are installing from your system software CD or disks,
click Custom Install. Select Apple Video Player from the
software list that appears, and then click Install.

The Apple Video Player application is installed on your 
hard disk (in the Apple Video Player folder in the Apple
Extras folder).

6 When installation is complete, click Restart.

Your remote control doesn’t work.

m The checkbox labeled Disable Remote Control may be
selected in the Preferences dialog box. Choose Preferences
from the Setup menu and deselect this checkbox (click to
remove the X).

m Try changing the remote control’s battery. 

m Try moving closer to your computer. If you are already very
close to the computer, point the remote control directly at
the remote control receiver on the front of the computer.

You can’t switch to TV when you press the
TV/MAC button on the remote control.

m You may not have selected TV as your video source. Choose
Show Controls Window from the Windows menu and click
the TV Video Source button.

You can’t switch to radio using the remote
control, or quit the radio using the remote control.

m There isn’t a way to turn the radio on or off using the remote
control.

123Troubleshooting



The Power button on your remote control doesn’t
work.

m You may have left a dialog box open. Close any open dialog
box, then try the Power button again.

You see static or a blank screen when you try to
watch TV or video.

m Be sure your video equipment is securely connected to 
the appropriate video input port and your equipment is
turned on. 

m Be sure your antenna or cable service is securely connected
to the coaxial port on the TV/FM tuner card.

m You may have the wrong video source selected. Go to the
screen controls in the Controls window and click the
appropriate Video Source button.

m Some static may result from poor reception over an antenna,
or from problems with cable service. Review the instructions
that came with your antenna or cable, or call the supplier for
assistance.

The image is too small or it’s filled with odd
colors.

m The video input standard is set incorrectly. Choose
Preferences from the Setup menu and select a different
setting.

You see a message that the built-in digitizer
cannot display video in the current monitor
setting.

m Reduce the number of colors or levels of gray your monitor
displays, using the control panel for monitors. (For more
information on adjusting a monitor, see Macintosh Guide if
it is available on your computer, or the print manuals that
came with your computer.)

124 Chapter 10



The image is too white or too dark.

m Adjust the video screen controls. (Choose Show Controls
Window from the Windows menu and click the video 
screen icon.)

m If you have a VCR connected to your video input card, make
sure you’re not having a problem with the videotape or the
VCR itself. (Connect the VCR back to your TV and play the
tape to see if the image is still bad.)

m The voltage output of your video equipment may be too
high or too low for the video input card. Therefore, your
video equipment may be sending video signals that are too
strong (causing a white picture) or too weak (causing a very
dark picture) for the video input card. Try connecting
different video equipment to the card.

You have a dark or “rolling” picture.

m Adjust the video screen controls. (Choose Show Controls
Window from the Windows menu and click the video 
screen icon.)

m If you have a VCR connected to your video input card, make
sure you’re not having a problem with the videotape or the
VCR itself. (Connect the VCR back to your TV and play the
tape to see if the image is still bad.)

m If your computer is also connected to a secondary monitor,
make sure that your connection goes from the VCR to the
monitor, ending at the video input card. (The connection
must end at the video input card, not the secondary
monitor.) Also check that your secondary monitor is set to
loop-through (also known as “Hi-Z”) input.

125Troubleshooting



You don’t hear the TV, or you hear the radio
instead of the TV.

m Make sure you have quit the Apple FM Radio application. To
do so, click the FM Radio window to make it active, then
choose Quit from the File menu. (You can watch TV and
listen to the radio at the same time, but the radio sound
takes precedence.)

m Be sure the volume on your computer is turned up. Use the
volume buttons on the front of your computer if you have
them, or use the sound-related control panel to adjust the
volume. (For more information on adjusting volume, see
Macintosh Guide if it is available on your computer, or the
print manuals that came with your computer.)

The sound is intermittent or clipped.

m Turn down the volume controls on your video equipment.
They may be set too high for the video input card.

m The voltage output of your video equipment may be too
high for the video input card. Therefore, your video
equipment may be sending signals that are too strong for the
video input card. Try connecting different video equipment
to the card.

The sound is full of static.

m Adjust the sound controls in the Controls window. (Choose
Show Controls Window from the Windows menu and click
the sound icon.)

m Turn up the volume controls on your video equipment.
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Unexpected things happen when you try to switch
modes using a keyboard shortcut.

m If you can switch between TV and computer using the
remote control, but have trouble switching using the
keyboard, check the hot key by choosing Hot Key from the
Setup menu. Be sure the key combination is not used by one
of your other programs. For instance, in most Macintosh
programsx-P sends a document to the printer. On the
desktop,x-N creates a new untitled folder.

You have a cable service and you can’t see any
channels above channel 13.

m Some cable services use HRC cable frequencies instead of
standard cable frequencies. If you can’t receive channels
above channel 13, choose Channel Setup from the Setup
menu and select HRC Cable from the Connection pop-up
menu.

You can’t see the Names pop-up menu on the
video window.

m You haven’t given a name to any channel. See “Giving Names
to Channels” in Chapter 6.

m You may have the wrong signal source selected. Each signal
source (antenna, or standard or HRC cable) has its own
channel list and potential list of channel names. Choose
Channel Setup from the Setup menu and make a different
choice from the Connection pop-up menu.

m If you had to reset your password because you forgot it, any
names you entered earlier for channels were erased. You
need to enter the names you want again. See “Giving Names
to Channels” in Chapter 6.

127Troubleshooting



You can’t see the volume slider on the video
window.

m The video window is too small or too large. Change the size
by making a choice from the Windows menu or by dragging
the size box.

Your password doesn’t work, or you forgot your
password.

m See “Forgetting a Password,” in the section “Creating and
Changing a Password” in Chapter 6 for instructions on
invalidating a forgotten password so that you can create
another password.

You can’t see closed captions when watching a
channel that provides them.

m The video window must be set to Normal Size or greater to
see closed captions. Change the size by making a choice
from the Windows menu or by dragging the size box.

m Quit networking or printing applications if they are active.
Closed captioning does not work well when networking or
printing is active.
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You’re playing a videotape with closed captions,
but the closed captions do not appear.

m To view a videotape with closed captions, you must connect
your VCR to a TV tuner port, not the video input card. For
instructions on connecting the VCR to the TV tuner port, see
the Appendix, “Viewing Closed Captions on Videotape.”
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If you want to view closed captions on a videotape that has
them, you must connect the VCR to the TV/FM tuner card.
(Normally, the VCR is connected to the video input card.)
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To connect the VCR to the TV/FM tuner card, remove the
cable that is attached to the TV tuner from the TV (keep the
other end of the cable attached to the TV tuner port on the
card). Then attach the cable to the video out port on the
VCR (remove the cable that is attached there now).

Now when you view the videotape with closed captions on
the computer, the closed captions appear with the video in
the video window.

Connect the TV tuner cable back to the TV when you want to
watch TV again.

Attach the coaxial cable
to the TV tuner port. The
TV tuner port is marked
with the      icon.

Coaxial cable

Attach the other end of the coaxial cable to
the video out F-connector port on your VCR.
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access cover for the TV/FM
tuner

on a compact computer
5, 14–15

on a modular 
computer  27

Add Channels dialog box
(Apple Video 
Player)  85

Add Preset Stations (Options
menu/Apple FM Radio)
52, 54–55, 57

alert sound  62, 63
antenna TV connection

82–83
Apple-authorized

dealer/service provider
purchasing a replacement

access cover for the
TV/FM tuner  5

purchasing a TV tuner
card  129

purchasing a video input
card  3

warranty questions  117
Apple FM Radio application

customizing settings
51–63

installing  42–43
listening to the radio

45–50
opening  46, 51
recording radio sound

65–69
troubleshooting  118–121

Apple FM Radio folder  46,
51, 65

Apple FM Radio Guide  47
Apple Video Player

application
customizing settings

81–96
installing  42–43
opening  72, 81, 97, 105
opening with a hot key

74, 96
recording from TV or

video  97–103
troubleshooting  122–129
watching TV or video on

your computer  71–80
Apple Video Player folder

72, 81
Apple Video Player Guide

73–74
Apple Video Player Prefs 

file  92
Apple Video Player 

Shortcuts  74
arrow keys on the keyboard

49, 76, 78
attaching connections to the

tuner card
compact computers

22–25
modular computers

30–33
viewing closed captions

and  23, 31, 129,
131–132
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audio cables, Y-adapter  36,
37, 39, 40

audio out ports on video
equipment  36–41

Auto Add feature for radio
stations  56–57, 61, 121

Auto Tune feature  83

B

back panel on a compact
computer, reattaching
18–21

balance and tone, adjusting
for TV/video  79

bass, adjusting for 
TV/video  79

beep, turning off  63
blank screen when watching

TV, troubleshooting  124
brightness of picture,

adjusting  80

C

cable service TV connection
choosing  82–83
troubleshooting  127

call letters, displaying on
preset radio station
buttons  55, 58–59

capture controls  98, 101
capturing TV and video

images  97–103
CD-ROM player, controlling

with the remote
control  115

changing
Color of Current Station

Text  62
passwords  91–92
preset radio stations  59

TV channels  76–77
TV reminders  95
video input standard  110
video window border

color  109
video window size

107–109
channel controls on the

remote control  77
channel list, displaying  82
channels

adding/restoring  85–86
changing  76–77
locking/unlocking  88–89
naming  86–87
removing  83–85

Channel Setup dialog box
82–83, 87, 89

Channel Setup (Setup
menu/Apple Video
Player)  82–89, 127

choosing
captured movie

compression rate  103
radio recording

compression rate
66–67

radio signal range and
strength  60–61, 
120, 121

radio sound mode  50
TV connection type

82–83
TV/video sound mode

78–79
video source  75–76

clearest stations
presetting  56–57
tuning in to  48
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Clipboard, copying screen
images to  99

closed captioning controls
106–107

closed captions
setting options for

106–107
troubleshooting  128–129
viewing on a videotape

23, 31, 129, 131–132
coaxial cable connectors,

illustration  23, 31
color

of picture, adjusting  80
of text showing Current

Station  62
of video window 

border  109
compact computer, installing

the TV/FM tuner card
in  4–25

composite video connectors
35, 36–38

composite video port (RCA-
type)  35

compression
for captured movies  103
for radio recordings

66–67
connecting

FM and TV antennas
22–25, 30–33

a VCR to the tuner card
for closed caption
viewing  23, 31, 129,
131–132

video equipment  36–41
connection type for TV,

choosing  82–83

connectors, determining
which type you 
need  35

contents of your package  2
contrast of picture, 

adjusting  80
Controls window (Apple

Video Player)  75–76,
78–80, 98–101, 106

copying a screen image to
the Clipboard  99

Copy Video Display (Edit
menu/Apple Video
Player)  99

customizing
FM radio settings  51–63
TV tuner settings  81–96

D

date and time control 
panel  24

descriptions, displaying on
preset radio station
buttons  58–59

disabling the remote 
control  116

disk storage required for
recorded movies

compression and  103
video window size 

and  102
displaying. See also viewing

channel list  82
information on preset

station buttons  58–59
keyboard shortcuts for

Apple Video Player  74
preset radio stations  55
TV reminders  93

DX range, choosing for radio
stations  60, 120
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E

editing TV reminders  95
Edit menu (Apple Video

Player), Copy Video
Display  99

Edit name dialog box (Apple
Video Player)  87

Edit Reminder dialog box  94
electrostatic discharge

damage, avoiding  6, 26

F

FM antenna
adjusting  119, 121
attaching to a compact

computer  22
attaching to a modular

computer  30
positioning for best

reception  25, 33
FM radio. See radio
FM Radio Preferences

window  58–59, 62–63,
66–67

FM Radio window  46–49,
52–57, 68

FM tuner port
on a compact 

computer  22
on a modular 

computer  30
forgetting a password  91, 92,

127, 128
freezing/unfreezing a video

image  99

frequencies
displaying on preset

buttons  58
typing  55, 59

F-type coaxial cable
connectors, illustration
23, 31

G

guides
on a compact computer

16
on a modular computer

29
under the logic board 

tray  13

H

handling the TV/FM tuner
card  11

help on screen
Apple FM Radio  47
Apple Video Player  73–74

hot key
troubleshooting  127
using to open Apple

Video Player  74, 96
HRC cable frequencies

83, 127

I, J

icons
Apple FM Radio  43, 46,

51, 65
Apple Video Player  43, 72,

81, 97, 105
Installer  42
sound  78
video camera  98
video screen  75, 80
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individual video images,
capturing  98–99

installing
Apple FM Radio  42–43,

118–119
Apple Video Player

42–43, 122–123
the TV/FM tuner card in a

compact computer
4–25

the TV/FM tuner card in a
modular computer
26–33

invalid channels, removing
from the list  83–85

K

keyboard control panel,
checking settings  24

keyboard shortcuts
for changing video

window size  108
displaying for Apple Video

Player  74
problems switching

modes  127

L

labeling preset radio station
buttons  58–59

local range, choosing for
radio stations  60

locking/unlocking channels
77, 88–89

logic board
removing  6–10
replacing  16–21

logic board tray  13

M

Memory control panel  100
modular computer, installing

the TV/FM tuner card
in  26–33

monitor, connection
problems with
secondary monitor  125

monophonic (mono) sound
for the FM radio  50
for TV/video  78–79

mouse control panel  24
movies, capturing  100–103
moving a preset radio 

station to a different
button  59

muting TV/video sound  78

N

naming
captured movies  101
radio recordings  69
TV channels  86–87

NTSC video input 
standard  110

numbers, displaying on
preset radio station
buttons  58

O

on-screen help
Apple FM Radio  47
Apple Video Player  73–74

opening
Apple FM Radio  46, 51
Apple Video Player  72, 81,

97, 105
Apple Video Player using a

hot key  74, 96
a movie you’ve 

captured  102
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Options menu (Apple FM
Radio)

Add Preset Stations  52,
54–55, 57

Preferences  58–59,
62–63, 66–67

Signal Range  60, 120, 121
Signal Strength  61, 

120, 121
Sound  50

P

package contents  2
PAL video input standard  110
passwords

creating/changing  90–92
incorrect/forgotten  92,

127, 128
locked channels and  89
removing  92

PICT files, saving images as  99
picture quality

adjusting brightness,
sharpness, contrast,
and color  80

compression and  103
playing back a radio

recording  69
ports

audio out  36–41
composite video (RCA-

type)  35
FM tuner  22, 30
sound input  38, 41
S-video  35, 40, 41
TV tuner  24, 32, 129, 132
video input card  3, 38, 41
video out  35, 37, 38, 

40, 132

power card  6
power switch on a compact

computer  6, 22
Preferences dialog box

103, 116
Preferences (Options

menu/Apple FM Radio)
58–59, 62–63, 66–67

Preferences (Setup
menu/Apple Video
Player)  103

preset radio station buttons
48, 52–53, 58–59

preset radio stations
assigning  53–57
changing  59
displaying list of  55
tuning in to  48–49, 52

Preset Stations window
54–57

programming channels
82–86

Q

QuickTime movies,
capturing video
sequences as  100–102

R

radio
controlling with the

remote control
112–113

listening to  45–50
recording from  65–69
troubleshooting  119–121
turning on or off

46–47, 51
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radio stations
presetting  52–59
tuning in to  48–49, 52

RCA plug connectors  35–38
RCA-type port  35
recording

from the radio  65–69
from the TV or video

equipment  97–103
Record/Stop button in FM

Radio window  67–68
reminders, setting for TV

shows  93–95
remote control

CD-ROM player control
buttons  115

channel controls  77
confirmation of Power Off

setting  116
disabling  116
FM radio control buttons

112–113
functions of  111
troubleshooting  120, 123
TV/MAC button  72, 81,

97, 105
TV/video control 

buttons  114
using  111–115
volume controls  49, 78

removing
access cover for the

TV/FM tuner  14–15
the logic board from a

compact computer
6–10

names from channels  87
TV channels from the list

83–85
TV reminders  95

reset button on logic board
17, 24

restoring TV channels to the
list  85–86

ribbon cable, attaching to the
card

on a compact computer
11–12

on a modular computer
28–29

S

SAP. See Second Audio
Program

Save Audio Recording dialog
box  69

saving
recordings from the 

radio  69
a video frame on disk  99

scrambled TV signals  84
screen controls  75–76, 80
searching for clearest radio

stations  48, 56
SECAM video input 

standard  110
secondary monitor,

connection
problems  125

Second Audio Program (SAP)
sound mode, selecting
for TV/video  78–79

security screws
on a compact computer

7, 21
on a modular computer

27, 29
Seek feature for radio

stations  48, 61, 121
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sequences of video images,
capturing  100–103

Set Channel Password,
(Setup menu/Apple
Video Player)  90–92

Set Channel Password dialog
box  90

Setup menu (Apple Video
Player)

Channel Setup
82–89, 127

Hot Key  96
Preferences  103, 116
Set Channel Password

90–92
TV Reminders  93–95

sharpness of picture,
adjusting  80

sheet metal logic board 
tray  13

Show Balloons  47, 73
Show Controls Window

(Windows menu/Apple
Video Player)  75,
78–80, 98–101, 106

Shut Down (Special menu)
6, 22, 26, 30

signal range and strength,
setting  60–61, 
120, 121

single video images,
capturing  98–99

size box, using to change
video window size  109

size of video window,
changing  107–109

slider
on the FM Radio

Preferences dialog 
box  66

on the FM Radio 
window  49

on the Screen Controls
window  80

on the Sound Controls
window  79

on the video window
77, 128

sound. See volume
sound controls  80
sound input ports  38, 41
sound mode

for the FM radio  50
for TV/video  78–79

Sound (Options menu/Apple
FM Radio)  50

source for video, choosing
75–76

speaker balance and tone,
adjusting for 
TV/video  79

Special menu, Shut Down  6,
22, 26, 30

static electricity, avoiding
generating  6, 26

static on TV, troubleshooting
124, 126

Step feature for radio
stations  49

stereophonic (stereo) sound
selecting for the FM 

radio  50
selecting for TV/video

78–79
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stopping recording
from the radio  68–69
from the TV or video  101

S-video, choosing as video
source  75–76

S-video connectors  35,
39–41

S-video ports  35, 40, 41
system software floppy disks

or CD
installing Apple FM Radio

from  118–119
installing Apple Video

Player from  122–123

T

Tab key, to move between
channels  77

television. See TV
text tracks for closed

captions  106–107
treble, adjusting for 

TV/video  79
troubleshooting

cable service TV
connection  127

can’t see closed captions
128–129

forgotten password  127,
128

installing Apple FM Radio
118–119

installing Apple Video
Player  122–123

Names pop-up menu
doesn’t appear on
video window  127

radio reception 
problems  120

radio sound problems
119–120

remote control doesn’t
work  120–121,
123–124

screen control
adjustments  125

Seek or Auto Add 
feature  121

switching modes using
keyboard shortcuts
127

TV reception problems
124–125

TV sound problems  126
using a secondary 

monitor  125
voltage output of video

equipment  125, 126
volume slider doesn’t

appear on video
window  128

tuning in to stations on the
FM radio  48–49, 52

turning off
the computer using the

remote control  112,
114, 115

the FM radio  47, 51
the remote control  116
virtual memory  100

turning on
Apple Video Player  72, 74,

81, 96, 97, 105
Apple Video Player using a

hot key  74, 96
the computer using the

remote control  112,
114, 115

the FM radio  46, 51
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TV
choosing a connection

type  82–83
choosing as video source

75–76
controlling with the

remote control  114
recording from  97–103
troubleshooting  122–129
watching  71–80

TV antenna
attaching to a compact

computer  24
attaching to a modular

computer  32
TV/FM Software Install Disk 1

42, 43, 118–119,
122–123

TV images, capturing
97–103

TV/MAC button on remote
control  72, 81, 97, 
105, 123

TV Reminders dialog box  93
TV Reminders (Setup

menu/Apple Video
Player)  93–95

TV tuner port  24, 32, 
129, 132

U

undoing changes  59, 63, 95
unfreezing/freezing a video

image  99
unlocking/locking channels

77, 88–89

V

Verify Channel Password
dialog box  90, 91

vertical plate  17
video

choosing as video source
75–76

controlling with the
remote control  114

recording from  97–103
troubleshooting  122–129
watching  71–80

video equipment
connecting for closed

caption viewing  23, 31,
129, 131–132

connecting to your
computer  34–41

controlling with the
remote control  115

voltage output of
125, 126

video images, capturing
97–103

video input card, checking
for  3

video input card ports  3, 38,
39, 40, 41

video input standard,
changing  110, 124

video out ports on video
equipment  35, 37, 38,
40, 132

video screen controls
75, 125

video source, choosing
75–76
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video window
adjusting TV viewing

76–78
changing the size of

107–109
Names pop-up menu

doesn’t appear  127
viewing channel names

76, 86
video window size, 

movie disk storage
requirements and  102

viewing. See also displaying
closed captions on a

videotape  23, 31, 129,
131–132

a movie you’ve 
captured  101

names of channels  76, 86
virtual memory, video

capture and  100
voltage output of 

video equipment,
troubleshooting
125, 126

volume, adjusting
for capturing movies  100
for the FM radio  49, 120
for a radio recording  69
for TV/video  77–78, 126

volume buttons on the
computer  49, 77

volume controls on the
remote control  49, 78

W, X

warranty on your Apple
equipment  117

wide (DX) range, choosing
for radio stations  60

Windows menu (Apple Video
Player), Show Controls
Window  75, 78–80,
98–101, 106

wire handle on logic board
10, 16

Y

Y-adapter audio cables  36,
37, 39, 40

Z

zoom box, using to change
the video window 
size  108
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